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ANEXO I 
 
 DESCRIPCIÓN DEL SIMULADOR HFSS 11 

 
 En este anexo, se muestra una visión del simulador HFSS 11, obteniendo los 
datos a través del fabricante y de la experiencia de uso [Ref. 11]. HFSS es un programa 
de simulación de campos electromagnéticos. Ello lo hace muy útil para simular antenas, 
guías de ondas o los campos presentes en una estructura de interés.  
 
 HFSS permite calcular campos eléctricos y magnéticos, corrientes, parámetros S 
o campos radiados tanto lejanos como cercanos [Ref. 11]. El modo de simulación 
empleado se basa en el método de los elementos finitos. Se trata de un método de 
aproximación [Ref. 17], que se constituye de los siguientes pasos: 
 

1) El continuo se divide en un número finito de partes, elementos, cuyo 
comportamiento se especifica mediante un número finito de parámetros 
asociados a ciertos puntos característicos, denominados nodos. Estos nodos 
son los puntos de unión de cada elemento con sus adyacentes. 

2) La solución del sistema completo sigue las reglas de los problemas discretos. 
El sistema completo se forma por ensamblaje de los elementos. 

3) Las incógnitas del problema dejan de ser funciones matemáticas y pasan a 
ser valor de estas funciones en los nodos. 

4) El comportamiento en el interior de cada elemento queda definido a partir 
del comportamiento de los nodos mediante las adecuadas funciones de 
interpolación o de forma. 

 
Se basa por lo tanto en transformar un cuerpo de naturaleza continuo en un 

modelo discreto aproximado. Por lo tanto, el usuario crea la estructura a simular 
mediante las herramientas de dibujo del programa, y este se ocupa de generar el mallado 
adecuado para obtener la solución. Esto se puede observar en [Fig.A.1]: 
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Figura A.1.- Mallado de una estructura simulada 

 
 

 El mallado se hará más fino cuanto menor sea el error que se quiera cometer con 
respecto al cálculo de campos continuos. Una vez que se ha llevado a cabo este mallado, 
el simulador HFSS 11, permite obtener y representar las soluciones que se han obtenido. 
Así, se puede representar la corriente superficial o los campos eléctricos o magnéticos 
en una estructura de 3D [Fig.A.2]: 
 

 

 

 
 
 
 
 

Figura A.2.- Representación de los campos electromagnéticos en la superficie de un 
avión 

 
 Para el desarrollo de antenas, el programa permite representar parámetros 
importantes de la misma como la ganancia o la eficiencia de radiación. Estas soluciones 
se pueden igualmente representar en 2D o 3D y permitirán cuantificar las características 
de las antenas. 
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Figura A.3.- Representación en Cartesianas, Pérdidas de Retorno de una antena 

diseñada 
 
 
 
 

 
Figura. A.4.- Representación 3D de la ganancia de una antena 
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 Además de este tipo de soluciones, el simulador HFSS 11 permite observar el 
error cometido en las aproximaciones de la simulación, así como exportar la matriz de 
parámetros S de la estructura, lo que facilitará el montaje físico posterior. 
 
 
 

 
Figura. A.5.- Representación del error en la simulación en HFSS 
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ANEXO II  
 

DESCRIPCIÓN DEL SIMULADOR    
MICROWAVE OFFICE 9.0 

 
 En este anexo, se muestra visión del simulador Microwave Office 9.0 
obteniendo los datos a través del fabricante y de la experiencia de uso [Ref. 12]. El 
simulador Microwave Office 9.0 se utiliza para simular circuitos integrados y diseños 
de RF, así como diferentes sistemas de comunicación. Se basa en técnicas lineales de 
simulación que utilizan el análisis de nodos.  
 

El análisis de nodos es un método sistemático para desarrollar análisis de 
circuitos. El procedimiento del análisis de nodos se divide en tres pasos: 

 
• Etiquetar los voltajes de los nodos con respecto a tierra. 
• Aplicar las leyes de corrientes de Kirchoff para cada uno de los nodos del 

circuito. Este método es el habitual de resolución de circuitos empleado 
en Teoría de Circuitos. 

• Resolver las ecuaciones establecidas para obtener las tensiones de los 
nodos desconocidas. Con ello resolveríamos el circuito planteado 

 
El simulador de Microwave Office usa técnicas orientadas a objetos para 

resolver los circuitos. Permite obtener soluciones en tiempo real, como la sintonización 
de elementos circuitales. Además, consta de una herramienta de optimización y análisis 
de campos. 

 
Para desarrollar una simulación Microwave Office, primeramente, se debe crear 

un proyecto nuevo File>New Project al que se le añadirán los diferentes esquemáticos 
de los circuitos a resolver Project>Add Schematic. 
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Figura. A.6.- Ejemplo Circuito esquemático en Microwave Office 9.0 

 
Las unidades de los elementos del circuito deberán ser fijadas a la hora de 

diseñarlo. Ello se realiza a través del menú de opciones del simulador Options>Project 
Options. Para poder representar las soluciones que se obtienen será necesario desplegar 
gráficas. Este apartado resulta muy importante, debido a la gran cantidad de medidas 
que se permiten representar.  

 
 Las gráficas las establecemos a través de la ruta Project>Add Graph y  se añade 

la medida a representar a través de Project>Add Measurament. En la figura siguiente, 
se observa un ejemplo de los distintos gráficos que se pueden obtener: 

 

                            Figura. A.7.- Ejemplo gráficos en MicroWave Office 
 
Entre las herramientas más útiles del simulador se encuentra la que permite 

sintonizar un elemento circuital. Esta opción se obtiene a través del menú 
Simulate>Tune, seleccionando el elemento a sintonizar. A través de la opción 
Simulate>Tune Pool, se puede variar el valor del elemento deseado. Gracias a la 
posibilidad que ofrece el simulador, se pueden obtener resultados en tiempo real a la vez 
que varía el valor del elemento circuital deseado. 
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Figura. A.8.- Menú con elementos sintonizados 

 
Otra herramienta muy útil para los diseños es el optimizador de Microwave 

Office, que permite ajustar los valores de los elementos de un circuito para obtener una 
solución deseada. La herramienta del optimizador se despliega a través del menú 
Simulate>Optimize. En ella se deben de especificar los elementos que se quieren 
optimizar para obtener la solución deseada. El objetivo de optimización se fijará en la 
opción Project>Add Opt Goal.  

 

Figura. A.9.- Menú del optimizador de elementos circuitales 
 
 
El error y el ajuste de los resultados obtenidos de la optimización se pueden 

obtener a través de la siguiente pantalla y de los gráficos de solución [Fig.A.9]. 
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ANEXO III 
 

PARÁMETROS BÁSICOS DE  ANTENAS 
 
 En este anexo se estudiarán los conceptos básicos sobre antenas que se han visto 
a lo largo del proyecto. La definición de antena según el Institute of Electrical and 
Electronics Engineers (IEEE) define una antena como aquella parte de un sistema 
transmisor o receptor diseñada específicamente para radiar o recibir ondas 
electromagnéticas. 
 
 La principal función de una antena es la radiación de una potencia suministrada 
con las características de directividad deseadas. A continuación, se explican los 
principales parámetros de las mismas. 
 

ANEXO III.1. IMPEDANCIA, RELACIÓN DE ONDA 
ESTACIONARIA Y ADAPTACIÓN DE LA ENTRADA 
 
La impedancia de entrada de la antena se define como la relación entre corriente 

y tensión entre terminales [Ref 13 pág.19]. Normalmente, la impedancia de una antena 
presenta una parte real e imaginaria, que dependen de la frecuencia: 

 
( ) ( )ωω AAA jXRZ +=          (3.1) 

 
ZA representa la impedancia de la antena, RA es la parte real de la impedancia de 

la antena dependiente de la frecuencia y XA representa la admitancia de la impedancia 
de la antena dependiente de la frecuencia.  De esta definición, se puede descomponer la 
parte real en dos, una que representa la resistencia de radiación de la antena y otra que 
representa las pérdidas óhmicas de las mismas.  

 

Ω+= RRR rA        (3.2) 
 

 
RA es la resistencia de la antena, Rr representa la resistencia de radiación y RΩ 

las pérdidas óhmicas en la antena. Esta definición permite establecer la potencia que 
radia la antena y la que se pierde disipada como calor en la antena. Ambas se definen 
como [Ref 13 pág.20]: 

   rer RIP
2=    (3.3)  ΩΩ = RIP e

2
      (3.4) 

 
  
 
 
 



Diseño de Antenas Inteligentes basado en la aplicación de un sintetizador de impedancias  

A-9 
 

Pr es la potencia radiada por la antena, PΩ es la potencia que se pierde disipada 
como calor, Ie es la intensidad equivalente suministrada por la fuente, Rr es la 
resistencia de radiación de la antena y RΩ es la resistencia óhmica de la misma [Ref. 13 
pág.20]. Un parámetro importante de la antena será su eficiencia o rendimiento. Se 
define mediante la relación entre la potencia radiada por la antena y la potencia que 
entrega el generador a la misma: 

 

( ) A

r

r

r

re

re

entregada

r
t R

R

RR

R

RRI

RI

P

P
=

+
=

+
==

ΩΩ
2

2

η          (3.5) 

 
ηt representa la eficiencia de la antena, Pr es la potencia radiada de la antena y 

Pentregada es la potencia que entrega el generador, que se compondrá la potencia radiada y 
de las pérdidas por calor.  

 
Además de la eficiencia de la antena, también habrá que tener en cuenta la 

adaptación entre el generador y la antena. En caso de no conseguir una adaptación 
adecuada entre ambas, se producirían pérdidas en la red que disminuirían 
considerablemente la potencia que se puede transmitir. 

 
La máxima transferencia de potencia entre generador y antena se dan cuando se 

cumplen las condiciones de adaptación conjugada: 
 
 

 
Figura. A.10.- Ejemplo línea de transmisión 

  

 
gA

gA

gA
XX

RR
ZZ





−=

=
⇒=  (3.6) 

 
 En el caso de adaptación conjugada la potencia entregada la antena coincidiría 
con la potencia disponible por el generador: 
 

 ( ) disponible
g

g

A

g

A

A

g

Agentregada P
R

V

R

V
R

R

V
RIP =

⋅
=

⋅
=⋅

⋅
=⋅=

442

22

2

2

2
      (3.7) 
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Pentregada y Pdisponible son la potencia entregada a la antena y la potencia disponible 
en la red y RA y Rg las resistencias de radiación de la antena y la del generador [Ref 13 
págs.21-22]. Si no se cumpliera el criterio de adaptación conjugada ambas potencias ya 
no coincidirían. En este caso la potencia entregada sería: 
 

 ( ) ( ) aT
g

g

g

AgAg

g

entregada C
R

V
R

XXRR

V
P ⋅

⋅
=⋅

+++
=

4

2

22

2

         (3.8) 

 
 CaT es el coeficiente de desadaptación de la antena. Su relación con la potencia 
disponible es: 

( )2
1 Adisponibleentregada PP ρ−⋅=            (3.9) 

 Ambas potencias estarían relacionadas a través del coeficiente de reflexión, cuya 
definición es: 

  
2

1 AaTC ρ−=        (3.10) 

  
gA

gA
A ZZ

ZZ

+
−

=
*

ρ       (3.11) 

 
 CaT es el coeficiente de desadaptación de la antena, ρA es el coeficiente de 
reflexión de la antena, ZA es la impedancia de entrada de la antena y Zg es la impedancia 
del generador. Este parámetro da una idea de la transferencia de potencia a la antena. El 
coeficiente de reflexión de entrada en un cuadripolo coincide con el parámetro S11 bajo 
la condición de que ZL=Zo, siendo ZL la impedancia de la carga del cuadripolo en 
cuestión. 

  
L

L
IN S

SS
S

Γ−
Γ

+=Γ
22

2112
11 1    (3.12)    

OL

OL
L ZZ

ZZ

+
−

=Γ     (3.13) 

  
 ΓIN es el coeficiente de reflexión a la entrada, ΓL el coeficiente de reflexión de la 
carga y Sab los parámetros S del cuadripolo, siendo a y b los puertos en cuestión. La 
relación de onda estacionaria SWR se define como la relación entre el mínimo y el 
máximo de la onda estacionaria de tensión o corriente que se forma a la salida del 
generador. En el caso de la onda de tensión, se utilizan las siglas VSWR y está 
relacionado con la adaptación de la antena: 
 

          ( ) ( )
( )f

f
fSWR

A

A

ρ
ρ

−
+

=
1

1
      (3.14) 

 
 SWR, es la relación de onda estacionaria y ρA es el coeficiente de reflexión de la 
antena, ambas dependientes de la frecuencia. Este parámetro ofrece una idea de la 
potencia que se ha transmitido a la carga. Será muy útil a la hora de determinar el ancho 
de banda de la antena. 
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ANEXO III.2   DENSIDAD DE POTENCIA RADIADA, 
INTENSIDAD DE RADIACIÓN Y DIAGRAMA DE 
RADIACIÓN  
 

 Una de las principales características de una antena es la capacidad para 
concentrar la energía radiada en una determinada dirección. Esta medida debe 
cuantificarse para poder llevar a cabo una comparación entre antenas.  
 
 En primer lugar, se establece el sistema de referencia  en el cual está situada la 
antena. El sistema utilizado habitualmente es el de coordenadas esféricas, en el que una 

dirección quedará definida a través de los vectores unitarios ( )φθ
rrr

,,r , que forman una 
base ortogonal como muestra la figura. 
 

 
Figura. A.11- Sistema de coordenadas esférico 

 
 La onda electromagnética radiada estará formada por una componente de 
intensidad de campo eléctrico y otra componente de intensidad de campo magnético. 
 

  




=
m

V
E
r

       (3.15) 

    

  




=
m

A
H
r

       (3.16)  

 
 Así, la densidad de potencia radiada por unidad de superficie vendrá 
determinada por la siguiente expresión [Ref. 3 pág.24]: 
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  ( ) ( ) ( )( ) 




×ℜ=℘
2

* ,,,
m

W
HE φθφθφθ
rrr

      (3.17) 

 
 La potencia total radiada se podrá obtener integrando la densidad de potencia 
radiada en una superficie S que encierra a la antena: 
 

  ( )∫ ∫ ⋅℘=
sr SdP

rr
φθ ,   (3.18) 

 
 Para los campos radiados en el espacio libre a una gran distancia de la fuente, el 
comportamiento a nivel local es el de una onda planta sin componentes radiales, cuyos 
módulos vienen relacionados por la impedancia intrínseca del medio η=120π Ω. 
 
 La densidad de potencia radiada también se podrá definir como [Ref 13 pág. 25]: 
 

  

( ) ( ) ( ) ( )( )
( ) ( ) ( )

η
φθφθ

η
φθ

φθφθφθφθ

φθ
222

*

,,,

,,,,

EEE

HE

+
==

=×ℜ=℘=℘
r

rrr

  (3.19) 

 
 Donde Eθ y EΦ son las componentes tangenciales del campo eléctrico, θ y Φ.  
 

La intensidad de radiación se puede definir como la densidad de potencia 
radiada por unidad de ángulo sólido en una determinada dirección. Su relación con la 
densidad de potencia radiada es de la forma: 
 

  ( ) ( ) 2,, rK ⋅℘= φθφθ   (3.20) 
 

 ( )φθ ,K  representa la intensidad de radiación. Para grandes distancias, se elimina 
la dependencia de la distancia a la fuente radiante. 
 
 El Diagrama de radiación de una antena es la representación gráfica de la 
densidad de potencia o la intensidad de radiación en las distintas direcciones del 
espacio, a una distancia fija [Ref 13 pág. 27]. 
 
 La representación se suele realizar en un sistema de coordenadas esférico en 
función de las variables angulares (θ, Φ). Los diagramas de radiación admiten varios 
tipos de radiación, como gráficos de 2D [Fig.A.13] o 3D [Fig.A.12], escala lineal o 
logarítmica, o representación cartesiana o polar. 
 

 
Figura. A.12.- Diagramas de radiación en 3D, isótropo, omnidireccional y directivo 
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Figura. A.13.- Diagrama de radiación en coordenadas polares y en cartesianas 

 
 Los diagramas de radiación suelen representarse normalizados respecto al valor 
de la dirección del máximo de radiación: 
 

 ( ) ( ) ( )
máxmáx K

K
t

φθφθφθ ,,
, =

℘
℘=   (3.21) 

 ( ) ( )[ ]linealdB tt φθφθ ,log10, 10=  (3.22) 
 
 En ocasiones, resulta suficiente con representar los cortes con respecto a los ejes 
representativos. Así, los más importantes son [Ref 13 pág.30]: 
 

 

2

0
2

πφ

φ

πθ

=⇒

=⇒

=⇒

PlanoYZ

PlanoXZ

PlanoXY

 

 
 También resulta interesante la representación formada por los planos 
fundamentales E y H. El plano E se define como el formado por la dirección de máxima 

radiación y el vector de campo eléctrico en dicha dirección,( )Ermáx

r
,ˆ . El plano H se 

define como el formado por la dirección de máxima radiación y el vector de campo 

magnético en dicha dirección,( )Hrmáx

r
,ˆ . 
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ANEXO III.3  DIRECTIVIDAD, GANANCIA DE ANTENA Y 
ANCHO DE BANDA 
 

 La Directividad ),( φθD se define como la relación entre la densidad de potencia 
radiada por una antena en una determinada dirección, a una distancia determinada, y la 
densidad de potencia que radiaría en esa misma dirección y a la misma distancia si la 
antena fuese isotrópica [Ref 13 pág. 33]. 
 

 

( )

24

,
),(

r

P
D

r

π

φθφθ ℘≡
     (3.23) 

 
 Si no se especifica la dirección angular se interpreta que es la directividad  en la 
dirección del máximo de radiación o directividad máxima. 
 

 
24 r

P
DD

r

máx
máx

π

℘
==

      (3.24) 

 

 máxD  es la directividad máxima y máx℘  la densidad de potencia radiada en la 
dirección donde es máxima y r la distancia a la que se quiere medir. El diagrama de 
radiación normalizado también se podrá escribir en función de la directividad: 

 

máxD

D
t

),(
),(

φθφθ =     (3.25)   

 
 La ganancia de la antena se define a partir de la potencia entregada por el 
generador. La relación entre ganancia de antena y directividad vendrá dada por la 
eficiencia de antena. Ambas coinciden si la eficiencia de antena es la unidad. 
 

 
( )φθη

π

φθφθ ,

4

),(
),(

2

D

r

P
G t

entregada

⋅=℘=
 (3.26) 

 

 ),( φθG  es la ganancia de la antena en una dirección determinada y tη  la 
eficiencia de la antena. 
 
  El ancho de banda se definirá como el margen de frecuencias para el cual un 
determinado parámetro se mantiene dentro de unos límites determinados. El criterio 
más habitual y el que se utiliza en este proyecto es considerar el margen frecuencial 
para el cual la SWR (Relación de Onda Estacionaria), es inferior a 2, o las Pérdidas de 
Retorno son inferiores a -10 dB [Ref 13 pág. 39]. 
 

 ( ) ( )
( ) 2

1

1
≤

−
+

=
f

f
fSWR

A

A

ρ
ρ

  (3.27) 

 ( )( ) dBfA 10log20 10 −≤ρ   (3.28) 
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ANEXO IV  
 
PRUEBA DE OBTENCIÓN DE 
RECONFIGURABILIDAD PARA UNA ANTENA 
DE TETRA 
 

ANEXO IV.1 SIMULACIÓN DE LA GEOMETRÍA 
RADIANTE 

 
 Una de las pruebas que se realizaron para la obtención de una antena 
reconfigurable en banda TETRA, consistía en conseguir hacer reconfigurable una 
antena que ya estuviera diseñada en esa banda. La antena escogida era de tipo 
microstrip, siendo el diseño simulado lo más fiel posible el artículo en el que aparecía 
especificada [Ref. 10 pág. 3]. 
 
 Así, la estructura que se diseño era la siguiente: 
 

 
Figura. A.14.- Antena a simular 

  
 Las dimensiones de la antena son las mismas que las indicadas en el documento 
de referencia [Ref. 10 pág. 3].El dieléctrico utilizado en este caso era aire εr=1, siendo 
alimentada con cable coaxial en el punto indicado en el esquema. La antena tiene una 
frecuencia de resonancia de fo=440 Mhz. y con un ancho de banda suficiente para cubrir 
la banda de trabajo de interés en los 460-470 Mhz.  Utiliza técnicas para  compactarla 
como la carga de un condensador o la inclusión de slots para aumentar su longitud 
eléctrica. Precisamente una de las ideas para la consecución de un diagrama 
reconfigurable consistía en variar la carga del condensador utilizado en el diseño. 
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Las simulaciones se configuraron para conseguir el mallado propuesto en el 
artículo [Ref. 10 pág. 2] y lograr reproducir los resultados del documento de la manera 
más fidedigna.  Los resultados que se obtuvieron de ellas coincidieron con los del 
artículo [Ref. 10 pág. 3-4]: 
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Figura. A.15.- Pérdidas de retorno de la antena simulada 

 
Figura. A.16.- Diagrama de radiación de la antena simulada. Cortes con el plano 

XZ (continuo) e YZ (discontinuo) 
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ANEXO IV.2 MODIFICACIÓN REALIZADA 

 
 Una vez conseguido reproducir los resultados, se pasó a buscar un diseño de 
antena con características reconfigurables. Para ello, debido a tratarse de un diseño ya 
predeterminado, el método más factible era el de lograrlo modificando el condensador 
del extremo de la antena formado por la masa y la propia estructura de la antena. Este 
condensador presentaba un valor de 0,5 pF. para el diseño original. La propuesta 
consistía en modificar este valor para cambiar su diagrama de radiación, pudiendo 
también añadir nuevas cargas para mejorar su adaptación de impedancias. 
 
 De este modo, se modificó la carga con valores diferentes de condensador. Se 
representa a continuación los resultados obtenidos  con 10 pF de carga: 
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Figura. A.17.- Pérdidas de adaptación con la antena TETRA y carga modificada 
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Figura. A.18.- Diagrama de radiación antena TETRA modificada. Corte plano XZ 

(continuo) e YZ (discontinuo) 
 

 
 Según [Fig.A.17] y [Fig.A.18], el modificar el diseño inicial de la antena supuso 
un cambio muy importante en cuanto a la adaptación de la misma. Las pérdidas de 
retorno habían aumentado y la frecuencia de resonancia se había desplazado en demasía 
con respecto a la banda original (fo=900 Mhz.). Además de eso, el diagrama de 
radiación que se obtenía no presentaba un cambio muy considerable con respecto al 
diseño original, con lo que el objetivo de conseguir una antena reconfigurable no se 
conseguía. 
 
 ANEXO IV.3 CONCLUSIONES OBTENIDAS 
 
 A raíz de los resultados obtenidos, se determinó que la solución propuesta no 
podía satisfacer las condiciones de reconfigurabilidad. Su diseño no permitía la libertad 
de poder modificar la densidad de corriente superficial en la antena sin cambiar en 
exceso su comportamiento frecuencial. Es por ello que para una solución posterior, sería 
necesario una estructura de antena que permitiera una mayor flexibilidad a la hora del 
uso de cargas para modificar sus prestaciones. 
 
 De los resultados obtenidos se concluyó que el obtener una antena 
reconfigurable supone un cambio, no solo en su diagrama de radiación, sino en su 
impedancia de entrada y, por lo tanto, en sus pérdidas de retorno. Por ello, resulta más 
útil realizar un diseño en el cual las diferentes configuraciones de la antena ya trabajen 
en la banda de interés que tratar de hacer reconfigurable una antena que no se preste 
para dicho comportamiento, a pesar de que ya resuene a la frecuencia objetivo. 
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 Para poder compensar el efecto de la variación en la frecuencia de resonancia de 
la antena, se estableció que el uso de un sintetizador de impedancias a la entrada podría 
corregir los cambios derivados de las modificaciones en la antena. Con ello, se varía la 
impedancia de entrada de la antena a la vez que cambia su diagrama de radiación, 
permitiendo fijar la frecuencia de resonancia del conjunto de la antena al objetivo 
fijado. 
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ANEXO V   
 
AMPLIACIÓN DEL ESTUDIO DEL 
ESTÁNDAR DE TETRA 
 
ANEXO V.1  CODIFICACIÓN Y MODULACIÓN EN TETRA 
 
En este anexo se ofrece una ampliación del estudio realizado en la memoria sobre el 

estándar TETRA, centrándose en la características de codificación y modulación, así 
como las aplicaciones en las que se utiliza. 

 
La codificación de voz en TETRA se realiza a través de un códec de la familia 

CELP [Ref.8 Anexo 1.2] que permite obtener calidad de voz aceptable con 4,8 Kbits. 
Esto facilita tener hasta cuatro canales simultáneos de voz.  

 

 
Figura. A.19- Esquema de los códec de la familia CELP 

 
Posteriormente, los bits de información se someten a un proceso de codificación, 

entrelazado y aleatorización que los protegerán frente a errores. Esto se consigue al 
evitar ráfagas de bits erróneos que distorsionan la comunicación. Para el proceso de 
codificación en TETRA, se utiliza un doble código [Ref 18. Tema 1]: 
 
• Un código bloque (n, k) para añadir redundancia en la comunicación. Se generan 

n=k+r, siendo n el número de bits generados, k el número de bits del mensaje 
original y r el número de bits de redundancia. 
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• Un código convolucional con rendimiento r=k/n, siendo las nomenclaturas 
utilizadas las mismas que en el caso anterior. 

 
Después del proceso de codificación, se pasa a un proceso de entrelazado y 

aleatorización que permite dispersar los errores y aumentar la privacidad de las 
comunicaciones. Para el proceso de entrelazado se almacenarán los datos en una matriz,  
reordenándolos en la transmisión. En la recepción habrá que revertir el proceso de 
aleatorización y entrelazado, lo que supondrá un retardo en las comunicaciones. 
 
  La modulación que se utiliza para las comunicaciones TETRA es de tipo 
diferencial π/4 DPSK [Ref.4 cap.5][Ref.5 cap.9.4]. Se trata de una modulación lineal en 
la que se añaden saltos de fase de π/4 en cada representación de un símbolo. En TETRA 
cada símbolo representa dos bits, por lo que se trata de una modulación multinivel. 
Además, al tratarse de una codificación lineal y diferencial se consigue suavizar los 
lóbulos secundarios en la transmisión y así cumplir con los objetivos de interferencias 
en los canales adyacentes que marca el estándar. Los símbolos que se transmiten lo 
harán del siguiente modo: 
  

S(k)= S(k-1)* exp(jDФ(k))      (2.1)  
 S(0)=1         (2.2) 

 
S(k) es el símbolo transmitido en el instante k, S(k-1) es el símbolo transmitido 

en el instante k-1 y DФ(k) es la diferencia de fase entre los símbolos. S(0) es el símbolo 
inicial o en el instante 0. 

 
 Las transiciones de fase se relacionan con los bits de demodulación como se 
observa en esta tabla: 

Tabla.A.1- Salto de fase en la modulación π/4 DPSK 

                
Figura.A.20- Constelación de símbolos de la modulación π/4 DPSK 

 
 

 

B(2k-1) B(2k)

1 1
0 1 + 3π/4
0 0 + π/4
1 0 - π/4

DΦ (k)

- 3π/4
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La expresión de la señal modulada será: 

 
 S(t)=Re(S(t)*exp(j2 πfot + dФo)              (2.3) 
 
 S(t) es la señal modulada temporal, que depende de la frecuencia de transmisión 
fo, del instante de tiempo t y de la fase inicial  dФo. 

 
ANEXO V.II APLICACIONES EN COMUNICACIONES 
MÓVILES 

 
 Los servicios de voz y datos de TETRA fueron estandarizados para su aplicación 
a todos los administradores de seguridad. Precisamente por ello, resulta un estándar 
muy útil para aplicaciones de fuerzas de seguridad tanto de ámbito público y privado, 
así como la gestión de servicios públicos como ferrocarriles o transportes urbanos. 
 
 Los servicios en redes TETRA suelen estar divididos en tres clases. A 
continuación, se presentan estas tres clases con algunos de sus servicios habituales 
[Ref.15]: 
 

Teleservicios, entre los que se encuentran: 
 
 Llamada individual, conectando a un usuario con otro usuario de la red. 
 Llamada en grupo,  conectando un usuario con otro grupo de usuarios. 
 Llamadas de difusión, normalmente desde el centro de control a todos los usuarios. 
 Llamada de emergencia, son llamadas con alta prioridad para una rápida conexión. 
 Operación en modo directo, donde los usuarios se conectan directamente sin 

utilizar la red TETRA. 
 Canal abierto, donde cada usuario puede hablar y escuchar libremente. 
 Inclusión de llamada. Incluir a un nuevo usuario en una llamada de grupo. 
 
Servicios de portadora, entre los que destacan: 
 
 Transmisión del estado del usuario. 
 Servicio de datos breves, similar a los mensajes SMS en las redes GSM. 
 Servicio de datos sobre circuitos conmutados. 
 Servicio de datos sobre paquetes conmutados. 
 
Servicios adicionales: 
 
 Servicios prioritarios y prevención, como prioridad de acceso, llamada prioritaria 
de prevención, llamada en espera o transferencia de control. 



 


